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Product Requirements:

• Mac OS X 10.2 or greater

What's new in this version:

• Rewritten from the ground up in Objective-C and C. (Good riddance AppleScript! :-D).
• I've changed the name from Font Cache Cleaner to "Font Finagler", to better reflect 
where I hope to take the application in the future, namely, a general font utility/font 
management tool.
• Added a table view which lists the font cache files which were found, which will be 
deleted when using the "Clean" feature (so you know what's going to be deleted before 
deleting it).
• The Font Cache Cleaner feature now uses the standard OS X authentication dialog 
obtained through the use of the Authorization Services framework.
• Added the ability for Font Cache Cleaner to be run from a non-administrator account 
by typing an administrator name and password.
• Added the ability for Font Cache Cleaner to be run from a non-administrator account 
without requiring an administrator password for each subsequent use. (This feature is 
intended for design firms where the normal artist lacks administrator privileges. It works 
by allowing a system administrator to come to their machine once, and, from within the 
non-admin user's account, enter their administrator password to enable Font Cache 
Cleaner to work in "Administrator-Free" mode from then on.)
• Added a feature that shows the number of active fonts and the number of cached 
fonts.
• Added the ability to choose between a Shutdown or a Restart.

TO DO:
• Add "About Font Caching in OS X" which provides additional documentation on some 
of the possible underlying reasons for the use of font cache files, how the font caching 
mechanism works, and how Font Finagler fits into this picture.

Product Description:

If you're having problems like in the image below, it could be caused by corrupt font 
cache files. What appears to be happening is that incorrect or corrupted encoding 
vector information is being used when mapping the character codes as input by your 
keyboard to the glyphs they represent in the problematically cached font.
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You can use Font Finagler's Font Cache Cleaner feature to purge these cache files in 
an attempt to restore normal behavior, and to help rule out a font cache corruption as 
the sole cause of the problem. If, however, you use Font Cache Cleaner but the 
problem remains, then it could be caused by a font conflict, by a corrupt or less-than-
ideal-quality font, or by an underlying OS X font-handling bug. Try removing fonts to 
isolate the problematic fonts that are causing this behavior.

Directions for use:

The image below shows the main Font Finagler window, including the toolbar. Currently, 
there are two features: Font Cache Cleaner, and Administrator-Free Font Cache 
Cleaner. Since they essentially perform the exact same function, under most 
circumstances you'll simply use one or the other. Which one you use depends on what 
type of control you have over your computer. By default, when you set up your Mac, the 
account that's created has administrator privileges, which allows you to do such things 
as install software, etc. This is the type of account you'll need to be able to use the 
normal Font Cache Cleaner function, which requires administrator privileges. To use the 
regular Font Cache Cleaner feature, this is the type of account you'll need, where you 
have total control over your computer. (If you like, you can remove the Admin-Free Font 
Cache Cleaner toolbar item by customizing the toolbar: choose View > Customize 
Toolbar… or hold down the Command-Option keys and click on the oval toggle toolbar 
button in the upper right-hand corner of the title bar). If, on the other hand, you have a 
network administrator or another person who oversees your computer, and you're a 
"non-administrator" user, you'll need to have that person enable the Admin-Free Font 
Cache Cleaner feature for you to use. That will allow you to clean the font cache files 
without requiring you to know an administrator password.
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Font Cache Cleaner:
Click the "Inspect Font Cache Files" button to search for and locate the font cache files 
on your hard drive, which Font Cache Cleaner will display in the table view. The 
"fontTablesAnnex" font cache file, which is the primary cache file, will be analyzed to 
determine the number of cached fonts on your system. To reveal any of these font 
cache files in the Finder, either choose "Show Font Cache File" from the File menu, or 
double-click a row in the table view to show the corresponding cache file. Click the 
"Clean Font Cache Files" button to execute the cleaning. Note that because several of 
the font cache files reside in the System Domain (/System/ folder), an administrator 
password is required to execute the cleaning procedure. After the cleaning is complete, 
a restart dialog will appear, where you can choose to either restart or to shut down. (See 
the "Restart Required" section below for more information on why a restart is 
necessary).

Administrator-Free Font Cache Cleaner:
The Admin-Free Font Cache Cleaner works the same way that the normal Font Cache 
Cleaner feature works, only administrator-level authorization is not required. Click the 
"Inspect Font Cache Files" button to search for and locate the font cache files on your 



hard drive, which will be displayed in the table view. The "fontTablesAnnex" font cache 
file, which is the primary cache file, will be analyzed to determine the number of cached 
fonts on your system. To reveal any of these font cache files in the Finder, either choose 
"Show Font Cache File" from the File menu, or double-click a row in the table view to 
show the corresponding cache file. Click the "Clean Font Cache Files" button to execute 
the cleaning. After the cleaning is complete, a restart dialog will appear, where you can 
choose to either restart or to shut down. (See the "Restart Required" section below for 
more information on why a restart is necessary).

Restart Required:
Since releasing version 1.0 of Font Cache Cleaner, I've looked into the possibility of 
removing the requirement for an immediate restart, as I thought it may have been 
overkill. After doing some further testing, however, I've decided to continue to keep it as 
a requirement. While deleting the font cache files doesn't seem to cause any immediate 
harmful effects, I don't think the ATSServer appreciates it too much, as afterwards, no 
new cache files are created like they are when you restart. Further research has also 
suggested that a log out and log back in isn't sufficient either; rather, a restart is a must.

License:

I've changed the license of Font Finagler (formerly Font Cache Cleaner) from freeware 
to $10 shareware. Your support will help ensure that I'm able to continue development 
of Font Finagler full-time. 

Support:

If you have a question or concern regarding Font Finagler, feel free to instant message 
me at AIM buddy name MarkDouma46 (MarkDouma46 for Jaguar people, in case that 
link doesn't show up) or to email me at mdouma46@mac.com (mdouma46@mac.com 
for Jaguar people).

If you could instant message me, that would be preferred, as it's much more conducive 
to troubleshooting. If you've never used iChat or AIM before, then don't worry about it, 
email is fine.

NOTE: If your question or concern is not directly related to this or another of my 
applications, or is of a more general nature, I can't necessarily guarantee a response. In 
a case like this, I'd recommend posting your question in Apple Discussions ( 
http://discussions.info.apple.com/webx?13@197.f8IoapUeirY.20@.599b236d ) where 
you have a community of 1000's of users that are ready and waiting to help you.

Disclaimer and Limitation of Warranty:

Copyright © 2004, Mark Douma. All rights reserved.
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Font Finagler cannot be sold by anyone other than Mark Douma (myself), either by itself 
or in combination with any other product, without my express written permission. Font 
Finagler may be distributed for free over the internet as long as I'm notified 
(mdouma46@mac.com) of the exact download location and conditions, but only in the 
form of the original Font Finagler distribution disk image, which must be bit-for-bit 
identical with the latest version published on my website 
(http://homepage.mac.com/mdouma46/fontfinagler/). If you would like to distribute Font 
Finagler on CDROM, please contact me before doing so; you may not do so without my 
express written permission.

By using all or any portion of this program, you accept all the terms and conditions of 
this disclaimer and limitation of warranty. There is no warranty for this program, to the 
extent permitted by applicable law. Except when otherwise stated in writing, the 
copyright holder and/or other parties provide the program "as is", without warranty of 
any kind, either express or implied, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose. The entire risk as to the quality and 
performance of the program is with you. Should this program prove defective, you 
assume the cost of all necessary servicing, repair or correction. In no event, unless 
required by applicable law or agreed to in writing, will the copyright holder, or any other 
party who will write supplementary software for this program and/or redistribute this 
program as permitted above, be liable to you for any damages, including any general, 
special, incidental, or consequential damages arising out of the use or inability to use 
this program (including, but not limited to, loss of data or data being rendered inaccurate 
or losses sustained by you or third parties or a failure of this program to operate with 
any other programs), even if such holder or other party has been advised of the 
possibility of such damages.

Font Finagler is "shareware", meaning that it is freely available over the internet or 
under other conditions described above, subject to certain restrictions of functionality 
and/or a periodic reminder to pay the "shareware fee". Should the user wish to remove 
these restrictions or reminder, the "shareware fee" may be charged under the conditions 
indicated above, in exchange for a "serial number" transmitted to the user. The user 
must treat this "serial number" as confidential and not sell, transmit, or reveal it to any 
other party. This fee may be refunded only if the user demonstrates, to my satisfaction, 
that entering the "serial number" into the latest version of Font Finagler, as published on 
my website, does not remove the restrictions. I reserve the right to disable, without 
notice, any "serial number" published on a website or otherwise made available to 
anyone but the original user.

Version History:

Font Finagler, version 0.5 November 5, 2004

• Rewritten from the ground up in Objective-C and C. (Good riddance AppleScript! :-D)
• I've changed the name from Font Cache Cleaner to "Font Finagler", to better reflect 
where I hope to take the application in the future, namely, a general font utility/font 
management tool.



• Added a table view which lists the font cache files which were found, and which will be 
deleted when using the "Clean" feature (so you know what's going to be deleted before 
deleting it).
• The Font Cache Cleaner feature now uses the standard OS X authentication dialog 
obtained through the use of the Authorization Services framework.
• Added the ability for the Font Cache Cleaner feature to be run from a non-
administrator account by typing an administrator name and password.
• Added the ability for Font Cache Cleaner to be run from a non-administrator account 
without requiring an administrator password for each subsequent use. (This feature is 
intended for design firms where the normal artist lacks administrator privileges. It works 
by allowing a system administrator to come to their machine once, and, from within the 
non-admin user's account, enter their administrator password to enable Font Cache 
Cleaner to work in "Administrator-Free" mode from then on.)
• Added a feature that shows the number of active fonts and the number of cached 
fonts.
• Added the ability to choose between a Shutdown or a Restart.

Font Cache Cleaner, version 1.0    March 15, 2004

• Initial public release


